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The Grand Interior

FOREWORD

Unlearning Whiteness 1

Architecture has been traditionally used as a tool to de-
fine and perpetuate colonial processes. It is an effective
agent of restraint able to assure the power of certain
social sectors over others. It is not neutral and it might
consequently be perceived as such. Modern urban
categories, as the division of public-private among
others, have been a driven force for the development
of biased social structures, but also other processes of
urban planning and building.

In particular in the United States, major cities like New
York, were divided by redlining, which defined those
neighborhoods denied to receive urban services by
federal government agencies, local institutions and
private sectors.2Those areas mostly inhabited by Black
and Indigenous and People of Color communities
were more likely to be redlined, consequently being
deprived of daily life services as health care centers,
schools or even supermarkets. Redlining, as many other
racial public processes, defined the city of New York and

despite several attempts to re-establish social rights,
there is still a lot that needs to be dismantled.

The Shift of Public Space

Today, thanks to the new digital landscape, Architec-
ture is becoming networked, inviting thus architects to
rethink fundamental disciplinary biased modern no-
tions. Digital technologies and new social behaviors
are undeniably modifying some assumptions of what
Architecture is supposed to be. Rather than the
physical spaces themselves, what has radically
changed is how we use them and how they relate to
each other and to the city: online platforms are
expanding the limits of
the house, connecting domestic spaces with the urban
environment.

Due to the actual transient social patterns, the classic
dichotomies between public-private, collective-indi-
vidual, night-day spaces… -or the division of the city
between areas of living from areas of leisure and pro-
duction- that characterized a great part of the
architec-



tural discourse of the twentieth century has lost its
connotation and does not respond anymore to how we
use and think of Architecture.

In our cities, uses and functions merge more and more,
both in the urban and the domestic sphere. Houses and
work places have become increasingly closer to one
another. Current digital sharing economy platforms
allow people not only to work from home, but also to
market their houses and domestic services online with
ease. From people offering their cupboards as shared
storage spaces, to people opening their living rooms as
temporary restaurants, we have a contemporary land-
scape of open spaces that go beyond the street and the
traditional city services, entering the domestic sphere.
The urban and the domestic are merging through this
new systemic tendency, defining a city built from frag-
ments that can be occupied and used on demand. This
increasing mix among interiors and exteriors, public
and private spheres, allows us to think of the world as a
continuous interior or following Sloterdĳk’s image as a
‘grand interior’, an endless domestic landscape defined
by spaces, objects and technologies,3where the public
space is being redefined.

These contemporary domestic practices that defy previ-
ous classifications but also the business model of tradi-
tional companies are endlessly debated and discussed
while labor rights continue to be exploited and wealth
concentrated. Indeed, these new social patterns and
economic logics have flourished online without regula-
tion, and have often only furthered extractivist regimes
and social injustices. On the other hand, in certain
circumstances, this realignment can contribute to new
symmetries, new forms of social and racial reconcilia-
tion that go beyond previous power structures and can
establish better social equilibriums.

A New and Fairer Grand Interior

Under this context, our perception of the city and its
Architecture differs, more and more, from the paradigms
of the last decades. While milestones such as 1978’s
book Delirious New York, shows a city defined by a set
of big envelope buildings on a grid, each enclosing a
world in themselves.4Today Architecture cannot be
understood detached from an interconnected reality,
where buildings, more than isolated entities, are part of
a larger system of common spaces and services that
link the micro with the macro, having consequences on
the political, the economical and the environmental at
large.

In Core I, we will understand Architecture in its net-
worked condition and the contemporary shift of public
space as an opportunity to redefine social structures for
a better common welfare. We will approach Architec-
ture from this perspective, unveiling and breaking down
historical racial constructions, those that still remain and
those that can dangerously happen.

We will address the course looking to our actual and
close reality, taking the everyday life of the city of New
York as a starting point and base for an architectur-
al proposal. We will look at buildings and their urban
context, understanding the quotidian as a platform for
a deeper research that will allow us to comprehend the
complexity of the built realm, its actual functioning and
requirements in relation to economic, climatic, environ-
mental, social and political issues. And we will design

Architectures that answer to those realities: transgress-
ing, empowering, complementing, … existing networked
spaces.

1. https://www.arch.columbia.edu/anti-racism-action-plan
2. https://dsl.richmond.edu/panorama/redlining/#loc=11/40.794/-74.12
8&city=- manhattan-ny&area=D10
3. Peter Sloterdĳk, P. In the World Interior of Capital: For a
Philosophical Theory of Globalization. Polity Press, 2013.
4. Koolhaas, R. Delirious New York: A Retroactive Manifesto for Manhattan.
Oxford University Press, 1978.



GENERAL TASKS AND EXPECTATIONS

The course will be driven by one main project titled
‘Broadway Stories’, which will be divided in five exercis-
es. Each exercise will be defined by a specific format,
each format will be focused on a specific scale and will
use a specific architectural representation technique.
Those restraints will allow us to approach the
complexity of our close reality and design it in a simple
manner. Each exercise will be analytical and at the
same time critical and propositive.

In Core I, there is no specific site predetermined, we
start researching our close context in order to raise an
architectural critical position. We design while re-
searching, we research while designing. We will learn
to understand our contemporary needs and to design
architectures able to redefine preset social
unbalances for better futures. We will produce
Architecture from the urban towards the detail, from
the drawing towards the construction, and during that
path we will always
foster graphical, formal and material experimentation as
an intrinsic part of the design process.

We expect students to:

-do qualitative and quantitative architectural research
and translate it into architectural language.

-gather, assess, record, and comparatively evaluate rel-
evant information and performance in order to support
conclusions.

-raise critical positions, formulating clear and precise
questions, using abstract ideas to interpret information,
considering diverse points of view, reaching well-rea-
soned conclusions, and testing alternative outcomes.

-respond to site characteristics, including urban context
and historical fabric, soil, topography, ecology, climate,
and building orientation.

-effectively use basic formal, organizational and envi-
ronmental principles and the capacity of each to
inform two- and three-dimensional design.

-consider the social impact of the design.

-consider the environmental impact and reuse of the
design.

-write and speak effectively and use
representational media appropriate for both within
the profession and with the general public.

-make technically clear drawings and construct models
illustrating and identifying the assembly of materials and
components appropriate for the design.
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BROADWAY STORIES

Framework
With a length of 13 miles, Broadway is the oldest street
crossing north-south the island of Manhattan. It runs
through a diverse compendium of realities, making the
observation of this particular street a suggestive exer-
cise that allows to unveil the complexity of the whole
urban structure, its reality and previous history, and
ultimately, to understand Architecture in its relational
nature. Broadway acts here as an element which allows
to put together a whole set of realities that permits a
cross-reading, from the object to the urban scale. Each
section in Core I will work on a specific area of Broad-
way, addressing its own particularities and problematics
in relation to public space and racial injustices. From the
bottom to the top of the island the stories are as follows:

- Houston st.
Prof. Lindsey Wikstrom

Lower Manhattan is a dense layering of historic and
contemporary spaces and events enmeshed in the
creation and protection of value. Along Broadway from
Battery Park to Houston, clusters of buildings are
currently designated as civic, financial, or for manu-
facturing; some still representing a link to some of the
area’s earliest land uses. Outside the wall, from which
we now have Wall Street, used to be The Commons and
the African Burial Grounds, two landscapes that were
part of everyday life in New York for nearly 200 years.
Both sites of extraction were physically external to the
city, but functioned as the primary means by which the
internal prosperity of the city, private property and ma-
terial ownership, were enhanced. Over time, extraction
sites have been removed further and further outside the
city, but are critical to the function of the city. Students
will be asked to examine accumulation along Broadway,
considering the reciprocal sites of occlusion elsewhere,
and exposing extraction’s continued adjacency to the
erasure of the contribution to the built environment
by Black, Indeginous, and People of Color. With this
in mind, students will respond with arguments for the
deconstruction and reconfiguration of this accumulated
material to ultimately propose a new material commons.

Houston st. - W30th
Prof. Amina Blacksher

It is incumbent upon any architect to know of the ground
on which they stand, the ground upon which they will
ultimately build.

The studio will employ a lens of historical criticality as
we analyze Broadway and its surrounds from Houston
Street to 30th Street. The region, today comprising three
major historical districts, Noho, Flatiron and Madison
Square North will be approached through a series of
temporal overlays. Guided by pivotal events spanning
from Broadway as a thoroughfare - originally known
as the Wesquaegeek Trail - to the 300 acres of African
owned farms known as Land of the Blacks under Dutch
colonial rule which centered around present-day Wash-
ington Square Park, and including the impact of the East
Village/Noho artist movement of the 1980s in which
artists shifted the public consciousness.

Students will construct spatial hypotheses grappling

with scale, ownership, property, land, appropriation,
center narrative, the concept of ‘for the public good’
and be sufficiently conversant in forces that govern
public use in order that final spatial proposals produce
expres- sions that are both imaginative and critically
poignant.

Through the use of the orthographic cut, students will
dissect history as a stack, responding to the figuration
and reconfiguration of society as a continuum. Through
the study of precedent sites students will cultivate an
understanding of the flow of placement and displace-
ment, of land and belonging, transpiring over time in
the horizontal plane. Finally through the articulation of
the section, the theme of the studio, Cutting Through,
students’ design proposals will seek to reveal and acti-
vate historical and contemporary truths hiding in plain
sight. Amongst a suite of techniques outlined in the
Core 1 syllabus, student proposals will present
concepts utilizing the architectural convention of the
cut, namely, techniques of orthographic cuts, in
horizontal and verti- cal planes, to reveal the
significance of their conceptual provocations on public
space.

W30th - Columbus Circle
Prof. Carlyle Fraser
At a time when the world is in a state of flux and uncer-
tainty, there is a need to reflect upon its varied origins
and rediscover life on earth and the greatness of its
shared past that defers to truth and equality for all. As
during the birth of this diverse nation, it is necessary to
recall the freedoms that make New York the epicenter
of new thought, culture, opportunity, and change in an
illu- sive city that has died and has been reborn once
more.

Broadway cuts diagonally across virtually every ma-
jor organ of the city passing through the heart of Time
Square and continues further beyond the cultural soul
of Lincoln Center. Students will study the residual
public pockets along this artery and how they are
stitched together to become the fabric of the city and
platforms for voice. These exchange places are public
interven- tions within the network that become
mechanisms for paradigm shifts and where many
different levels of interaction occur to provoke change.
The government, economy, media, and streets support
numerous activi- ties and movements that are the
result of both evolution and revolutionary processes.
Today it is essential to un- derstand their complexity,
and where social technologies such as twitter,
facebook, and other forms of media can be of avail.
Moving between precincts that comprise the institution
where people will discover communal places to gather
and secret places to be alone in research and
contemplation. These local forums are a palimpsest
meant to be explored and discovered over time
through its history. In doing so these local interventions
will be for all who search to belong, a place where
alternative positions intersect, friendships are formed,
and where the unimagined can happen.

Urban sites adjust to fluxing climates, ecologies and
economies. We offer extraction as a strategy for

Columbus Circle - W87th 
Prof. Christoph Kumpusch



uncovering future possibilities. We imagine water, wind
and sun to power the city. What effect does it have on
its original environment? What does water reveal?
What’s the sound of wind? What do flood patterns
foretell? Nature Works proposes a speculative field of
what remains and what is possible.

In Nature Works: Situation NYC, we begin in a
suspended stretch of New York City’s Broadway. The
sounds are under water and earth, taken from within
the social, architectural, urban space itself and from
multiple non-binary typologies and topologies. In the
space of the city, temporal encounters create new
associations as we imagine new ways of moving
through the shifting ground. We engage variations of
scale including the urban, intimate and infinite. They are
absorbed and invented, appear and disappear:
1:100
1:25000
1:20
3:1
1:50
1:500
1:50000
2:1
1:1
1: ∞ …INFINITY (∞), along with its symbol ∞, is not a
number and it is not a place. There is no limit to its
values. We then say that the values become infinite, or
tend to infinity – a limit is a number. There is no number
that we can name.

W87th - W120th
Prof. Galen Pardee
Broadway provides a direct connection between two
real estate titans in the City of New York: the Trustees
of Columbia University, and the New York City
Housing Authority (NYCHA). Columbia University
stands as New York City’s second-largest private
landlord by number of properties owned—claiming
246 buildings and vacant lots—and seventh-largest by
total square footage. A “city within the city”, NYCHA is
the landlord for one in every fifteen New Yorkers, with
their 334 developments totaling 178,895 apartments
and 2,602 buildings. NYCHA faces a $77 million
budget gap and a $40 billion-dollar shortfall in
deferred maintenance across its campuses as their
residents make do in moldy apartments with uncertain
access to air conditioning and heat, unreliable
elevators and building systems, and inaccessible
gardens. While singular examples of Columbia’s sway
over its’ Black and Latino neighbors abound, in many
ways access to basic maintenance and high-quality
materials within Columbia’s holdings relative to
NYCHA provides a more granular, systemic
demonstration of this power dynamic on a daily basis.
This studio will consider the logistics of material and
services, the politics of labor, construction, and
development, and mechanisms of land acquisition and
control as well as forfeiture and enclosure, as metrics
of how political influence (or lack thereof) might be
measured within the City.

On paper, NYCHA and Columbia University appear to
be similar entities from a design and construction
standpoint. Both share access to similar pools of
labor, control largely residential portfolios of buildings,
and face similar maintenance demands inherent to
multi-family buildings (elevators, boilers, heating and
cooling, etc):however the reality on the ground
presents a different story entirely. Understanding the

physical and political impacts of who has access to
architectural services to build, repair, and renovate is
critical to understanding who wields political power in
Morningside Heights and Manhattan Valley.

W120th - W152nd
Prof. Alessandro Orsini
The studio aims to re-envision the urban voids of
Harlem between 120th-152nd street as an opportunity
to create new opportunities for the commons. Since
urban voids — in the form of vacant land and
buildings — directly relate to the gentrification of
neighborhoods and the continuous spatial
re-arrangement of underrepresented communities in
the area, primarily African Americans and Latin X, the
making of the new commons will generate tools to
reject the violence of racial capitalism.

Students will investigate the history of these
interruptions of the city fabric to determine what and
who generated these voids, to whom these plots of
land belonged before becoming unused. Students will
be asked to articulate strategies to reconfigure the
urban fabric of West Harlem along Broadway,
enabling equitable and inclusive visions that
transcend the nuclear family and facilitate alternative
leisure, working, and educating arrangements
focusing on spaces of care for local youth. We will
provide safe spaces for LGBTQ youth, sometimes
unhoused, and historically important for the local
culture of our study area. We will target discriminatory
urbanization patterns that will be re-oriented towards
collective models of ownership and responsibility for
"the commons," defined as the space that ensures
access to food, education, shelter, civic engagement,
and meaningful work for all.

This approach to the evolution of the cities can be at
the base of the nation's urban policies and planning
revolution, where the collective is at the center of
society's well-being and prosperity.

W152nd - W184th
Prof. Virginia Black
In this introductory architecture studio, we will
question architecture as a way of knowing and
engaging with the world. Working within, through, and
against the frames we’ve been given, we will begin to
see “Broadway Stories,” and this syllabus, as an
apparatus that constructs possible worlds. Beginning
on our site, we will read and craft images of the city,
considering whose histories have been rendered
legible or illegible, and the ways those histories have
been read as fact or fiction; we will examine our own
tendencies to believe or disbelieve, in the process
questioning the types of aesthetics we associate with
credibility or lack thereof. Drawing will serve as a
primary site of investigation: we will draw to better see
architecture as material-discursive practice and as an
instituting force and engage with representational
tools as they shape the way we see, understand and
operate in the world

The area of Manhattan we will work within--only four
blocks from West to East at its narrowest--is a space
informed by institutions operating at vastly different
scales: here and elsewhere, gender, family, health
and nationhood are projects crafted between registers
as abstract and wide-reaching as international law
and as intimate as individual gestures. The wave of a



hand, the scanning of an ID, a wink or a nod mediate
access and shape our realities just as much as pipes,
bridges, and whatever else might be considered
architecture’s primary media.

W184th - Beyond and Elsewhere (s)
Prof. Patti Anahory

    
         

        
      
        
       

 
Architecture operates as a mechanism for the 
reproduction of meaning and value. We will immerse 
ourselves in an entanglement of narratives and spatialities 
that provoke locative notions of belonging. We seek to 
embrace the territorial as a means to counter binaries of 
valuation/devaluation, possession/dispossession found 
among built and natural environments.
The studio will summon cartography as both a device of 
erasure and a form of storying the world to explore ways 
to read, reveal, repair and fabulate spaces of otherwise. 
We will consider how spatialities of rupture challenge 
architecture’s scripted notions of boundary-marking, 
citizenship and migration.
To escape the narration of northern Manhattan island as a 
less desirable edge, our studio will seek possibilities of 
radicalizing this margin and will engage the elsewheres of 
Inwood as an amplification of its shared imagining of 
ecologies and cosmologies.
There are no undesired geographies.

Our studio will critically engage with the tools and 
methods of an architecture taking place. This semester 
we will investigate how historically-construed hegemonic 
acts such as praxis, discourse, discipline and language 
have restricted ways of understanding, thinking and 
inhabiting worlds.

   [storying] cartographies of [belonging] otherwise
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BROADWAY STORIES
Exercise 1

Tasks
To understand the Architecture of the city means also to
select those aspects and elements that define it. In the
drawing, the architect has the best tool for performing
this exercise of abstraction. Drawing obliges to select
the precise features that identify elements in different
scales from details to urban fabric, representing and
emphasizing them and their relationships. Thus, rep-
resentation is not an objective tool, as it always relies on
different perspectives, that allow to unveil sometimes
unperceivable realities and, at the same time, raise criti-
cal positions towards architecture and the city.

Individual work - Qualitative research: Through the
direct observation of the city and related graphical ma-
terial of your particular area of Broadway, produce a set
of three drawings using just black lines (no hatch) that
express the Architecture of the Avenue. The drawings
have to capture the physicality of the city as well as
as other unphysical elements that are essential to the
context. The outcome has to offer enough graphical
information to be able to understand its nature. All the
elements that are not perceivable but essential to the
city, have to be speculated and designed accordingly.
Look, draw and design critically:

-enclosures
-buildings
-materiality and construction of its buildings
-underground spaces
-infrastructures
-water supply
-light
-color
-everyday life objects
-vegetation
-types of actions and movements
-timings and sequences
-more…

Work in groups of 2 - Quantitative research: Answering
to your section’s brief, collect data and other type of
quantitative knowledge of your particular topic, and pro-
duce a set of two drawings using black lines (no hatch)
translating all sorts of information into architectural rep-
resentations . Research, find, draw and design critically:

-density
-race
-population age
-real state value
-consumption resource
-social data
-history
-air pollution
-more...

Expectations
The student is expected to understand a physical reality
speculating about the visible and the invisible, and is
expected to translate it into an architectural language.
The work has to show a control of classical architectural
representation techniques: plan, elevation, section and
axonometry. The work has to show also a capacity to
abstract ideas into drawings, and to translate research
into architectural representations. The type of rep-

resentation must be chosen according to the informa-
tion that has to be communicated. Drawings have to be
properly composed and show an adequate use of line
weights, line types and other graphical tools. The draw-
ings have to be as simple as possible and at the same
time have to express as much information as possible.
The student is expected to be able to work in pairs and
individually summing up in a few drawings the whole
complexity of the city and its Architecture.

Deliverables
A set of 5 diverse black and white drawings, using
black lines (no color or hatch allowed), they should
include: floor plan, section, axonometry, urban map,
diagram

Format:
A set of 5 black and white vertical drawings printed on
white paper, 36”x24”.
Also, upload them to Canvas as:
Vector images (line work, such as AutoCAD or Illustrator
drawings) should be saved in PNG format.
PNG: max dimension of 2000 pixels at 72dpi; max file
size: 3MB

Timeframe
September 9th– September 23th

Collective Review
Friday, September 23th



BROADWAY STORIES
Exercise 2
Following the evolution of your project, build a site mod-
el, adding all the context that is relevant for your
propos- al. Include your construction in a collective
Broadway Avenue model. Your project will be suddenly
part of a complex set of designs dialoguing with each
other.

Expectations
The student is expected to be able to select and build
accordingly those parts of the context that relate to the
project. The models have to be as simple as possible
and at the same time have to express as much infor-
mation as possible. The student is expected to be able
to work collectively in a large group, being responsible
at the same time for both the individual work and the
collective result. Coordination and time management
will be crucial.

Deliverables
A collective model of Broadway (material and scale to be
determined), each group has to deliver its own fragment.

Timeframe
September 24th– October 10th

Collective Review
Friday, October 10th

Exercise 3
Tasks
Understanding the particularities of your area and your
section’s brief, raise a critical and coherent position in
relation to existent or historical racial injustices and their
relation to public/common/collective spaces, through the
design of a new space or set of spaces that can op-
erate together as a part of a network. The new Architec-
tures should empower, compete, transgress, compen-
sate, erase,… existent parts of Broadway.

Produce a set of color masses drawings to communi-
cate your architectural design, describing the relation –
physical, economical, political,…- between those spac-
es and the city at large. Also, understanding your critical
position, push further your quantitative research and
produce a set of two color mass drawings complement-
ing your collection of data and other type of knowledge
of your particular topic.

Expectations
The student is expected to be able to analyze the city
and its contemporary reality, and to raise a critical and
coherent position in relation to social justice and the
actual condition of public/common/collective space
through the design of a new space or set of spaces.
The student is expected to design, experiment and
control space values as form, proportion, scale, light,
color and materiality. Through the set of color drawings,
the student is expected to show in an adequate way
the narrative and critical position behind the existing
spatial system and the new Architecture. The type of
representation (plan, section, detail, axonometric,…)
must be chosen according to the information that has
to be communicated. Drawings have to be properly
composed and show an adequate use of color mass-
es. Design speculation and drawing experimentation
is encouraged. The drawings have to be as simple as
possible and at the same time have to express as much
information as possible. The student is expected to be

able to work in pairs and individually summing up in a
few drawings the whole complexity of the project.

Deliverables
A set of 5 color drawings, using masses of color (no
black color), they should include:
floor plan, section, axonometry, urban map, diagram

Format:
A set of 5 black and white vertical drawings printed on
white paper, 36”x24”.
Also, upload them to Canvas as:
Raster images (renderings, photographs, or collages)
should be saved in JPEG format.
Vector images (line work, such as AutoCAD or Illustrator
drawings) should be saved in PNG format.
JPEG: max dimension of 2000 pixels at 72dpi; max file
size: 3MB
PNG: max dimension of 2000 pixels at 72dpi; max file
size: 3MB

Timeframe
September 24th– October 14th

Collective Review
Friday, October 14th

Prepare for
Mid Term
Review
Mid Term Review
Wednesday, October 26th

Friday, October 28th



BROADWAY STORIES
Exercise 4

Tasks
Build a set of home made models of the interior of your
designs to be photographed in order to explain your
ideas. Use domestic elements such as food, packaging,
leftovers,... to build stage sets that are able to express
the value and atmosphere of those spaces. Reuse
material as much as you can. The scale of those
models have to be chosen in coherence with the
project. Consider that those models are built to be
photographed, they can
be fragmented, as theatrical scenarios. Work with light,
color, materiality,… Produce a set of photographs of
them.

Expectations
The stage sets must show precision and delicacy, exe-
cuting in a detailed and accurate manner the interior of
each space. The photographs of the models have to be
properly produced, showing a correct selection of the
scenario, the viewpoint, the perspective, the use of light
and color. Design speculation and model experimenta-
tion is encouraged. The models have to be as simple as
possible and at the same time have to express as much
information as possible. The student is expected to be
able to sum up in a few photographs of models the
whole complexity of the project.

Deliverables
A set of 5 photographs of your interior space models,
printed on white paper, 36”x24” (to be confirmed).

Format:
Colorspace should always be set to RGB (Photoshop:
Image>Mode>RGB Color; Illustrator: File>Document
Color Mode>RGB Color)
JPEG: max dimension of 2000 pixels at 72dpi; max file
size: 3MB

Timeframe
October 31st– November 18th

Collective Review
Friday, November 18th



BROADWAY STORIES
Exercise 5

Tasks
Amock up, a fragment of a 1:1 construction, is an Archi-
tecture tool that allows us to experiment with construc-
tion. It pretends to be real, yet it remains fictional due to
the impossibility to contain the whole. It is a simulacrum:
a piece of Architecture in a state of limbo, between
reality and fiction. In this state of limbo imagination
emerges, constituting a subtle and contradictory entity
that embeds both the most radical forms of a reality still
to be unfolded, and, simultaneously, extremely volatile
materials prone to disappear. And precisely, there lays
its radical power: in the way it shows the possibility of an
alternative reality. In a world where construction sys-
tems are able to redefine global economies and ecolog-
ical attitudes, a mock up emerges as a critical device
for Architecture that allows us to reflect beyond the built
realm.

Understanding the radicality of mock ups, experiment
with future materiality, color, form, construction sys-
tems... Build a mockup or a set of 1:1 constructions of
your design, choosing materials that are coherent with
your project argument, and that have a low impact on
our environment. Be aware of their origin and system
of production. Consider possible afterlifes, reuses and
recycle procedures. Take photographs of these con-
structions, and generate a GIF able to communicate the
process of construction. Also, translate the mock up into
one single 1:1 construction detail drawing using black
and white lines.

Expectations
Through the 1:1 construction, the student is expected to
design and experiment with materiality and technical re-
quirements. The outcome has to show experimentation
and evolution, as well as environmental awareness. The
student is also expected to know how to translate those
experimentations into photographs and drawings.

Deliverables
Constructions 1:1 of fragments of the design. MIN
2x2x2’ MAX 3x3x3’.
Take 5 photographs of those constructions, printed on
white paper, 36”x24” (to be confirmed).
1 GIF showing construction procedures, 30 sec each,
max 10MB MP4 or MOV, to be projected.
1 construction detail drawing in 1:1,printed on white
paper, 36”x24”.

Also, upload them to Canvas as:
Colorspace should always be set to RGB (Photoshop:
Image>Mode>RGB Color; Illustrator: File>Document
Color Mode>RGB Color)
JPEG: max dimension of 2000 pixels at 72dpi; max file
size: 3MB
Vector images (line work, such as AutoCAD or Illustrator
drawings) should be saved in PNG format.
PNG: max dimension of 2000 pixels at 72dpi; max file
size: 3MB
GIF 30 sec each, max 10MB MP4 or MOV

Timeframe
November 18th– November 30th

Collective Review
Wednesday, November 30th

Prepare
for Final
Term
Review
Final Term Review
Monday, December 5th

Tuesday, December 6th



SCHEDULE (EST)

STUDIO INTRODUCTION
Wednesday, September 7th

3-6pm
Location Avery 114

STUDIO HOURS
Monday, Wednesday, Friday
2-6pm
Avery 500 N

LECTURES tbc
Wednesday, 2-4pm, September 14th

Wednesday, 2-4pm, September 28th

Wednesday, 2-4pm, October 12th

Wednesday, 2-4pm, November 9th

DAY TRIP tbc
Saturday, September 17th
1-6pm

WORKSHOPS
Set Photography (Michael Vahrenwald), October 3rd-7th

Materials Assembly (Josh Jordan), November 14 th-18th

EXERCISES TIMEFRAME
EX1 September 9th – September 23rd

EX2 September 23rd – October 10th (Introduction of EX2 &
EX3 after Collective review of September 23rd)
EX3 September 23rd – October 14th

EX4 October 31st – November 18th (Nov. 7th & 8th Election
Day)
EX5 November 18th – November 30th

COLLECTIVE REVIEWS
Friday, September 23rd (EX1)
Friday, October 7th (EX2)
Friday, October 14th (EX3) TBC
Friday, November 18th

Wednesday, November 30th

MAIN REVIEWS
Mid Term Review
Wednesday, October 26th

Friday, October 28th

Final Term Review
Monday, December 5th

Tuesday, December 6th

GRADING

The submission of all exercises is compulsory to pass
the course. Class attendance is also mandatory. Any
absence must be adequately justified. Any student
nonattending to more than 3 classes won’t be able to
be graded.

Two assessments will be made during the course. After
the mid-review, the student will receive an orientation
assessment of the evolution done up to that moment.
This intermediate grade must be considered a pro-
visional assessment, a useful tool to understand the
virtues and defects of the work carried out until then. It
is a moment of reflection in order to know how to
improve.

To assess the exercises, the coherence of the student’s
response to the demands of the exercise, the virtue and
adequacy of the proposal made, the correction of its
graphic and material representation will be taken into
account. Exercises submitted after the delivery desig-
nated date, will not be evaluated.

Apart from the final outcome of each exercise, the final
grade will assess the student’s effort and evolution
during the course as well as their critical attitude.
Active attitude will also be valued, such as participation
in classroom discussions, collaboration with classroom
colleagues, expansion of the contents of the course
with own research, attendance at conferences and
alike.

In relation to grading, see more in the following link:
https://www.arch.columbia.edu/grades
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NY DATA SOURCES

https://www.data.ny.gov/

https://www.oldnyc.org/

http://www.maap.columbia.edu/module/index.html

https://www.urbanarchive.org/cities/nyc

https://dsl.richmond.edu/panorama/redlining/#lo-
c=11/40.794/-74.128&city=manhattan-ny&area=D10

SUPPLIES

Utrecht : 21 E 13th Stgeneral art supply, canvas, plaster,
paper, paint, brushes

Janoff’s : 2870 Broadwaywhite board, paint, metal, pia-
no wire, wood, foam core, cutting supplies

Compleat Sculptor : 90 Vandam Stplaster, resin, blacke-
ner, metal, rockite, casting information, wax, clay

Metalliferous : 34 West 46th Street, 3rd Floor soldering /
metal supplies

The Home Depot : 40 W 23rd Sttools, screws, nuts,
bolts, lumber, rope, paint, screen

Space Surplus Metals: 325 Church St aluminum, brass,
copper, steel

McMaster-Carr Supply Company : 473 Ridge Rd

AJO Ace Home & Lumber Depot : 610 Columbus Ave
lumber

Metropolitan Lumber Midtown : 617 11th Avenue tools,
materials -open 7 days-

Prince Lumber Co. : 404 West 15th Street

Pearl River Mart : 477 Broadway fabric, paper, boxes,
random other materials

University Hardwares : 2905 Broadway rockite, paint,
screws, nuts, bolts, tools, rope

FABRICATION LAB

https://www.arch.columbia.edu/research/facili-ties/2-
making-at-gsapp


